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My Building Software System Architecture 
The My Building software system architecture is that of a series of microservices running in 
a containerized environment, each executing their own specific role and function and 
interacting between each other and with the outside world following a defined set of rules. 
This architecture allows for a high degree of flexibility in deployment options as well as 
scalability. In addition to the microservices that make up the My Building application, there 
are a series of external applications which also may be containerized or may run stand 
alone. In all cases, care should be given to ensure that: 
 

• Persistent data store is outside the container 

• Processes for backup and restoration of data is well defined, monitored, and 
executed. 

• Tools are implemented for monitoring the installation and alerting the appropriate 
individuals when there are problems. 

The Leviton Lighting Control Systems & "The network" 

Before we further discussion about My Building system architecture, it's helpful to 
understand the basic layout of the lighting control network. First, looking at a single 
building deployment: 
 

• Lighting control Devices, like relays, dimmer, sensors, switches, keypads and the 
like, are located inside the room. They all communicate with each other on a local 
in-room network which can be "wired" using a proprietary protocol we call 
LumaCAN or "Wireless" using a protocol similar to Zigbee. All in-room devices are 
managed by a Room Controller. 

• All Room Controllers (RC), typically located one per room, communicate through a 
Wi-Fi network using MQTT/IP. The Wi-fi access points can be provided by Leviton or 
the customer. The customer is the preference. 

• Clients using a web browser from their computer or the My Building app on their 
phone communicate to the My Building software. 

o Note: in some cases, the app will make a direct TCP/IP connection to the 
Room Controllers 
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• The BACnet point of presence, ASCII interface for A/V, et all, if provided, is local to 
the building network and at the location of the Building Management or Building 
Automation Server. These device that exposes bacnet to the network is one of the 
My Building microservices and often runs on a constrained Linux device provided by 
Leviton, but also be virtualized. 

• My Building uses email for some notification, a SMTP server is required and should 
be provided by the local site IT team 

 
 
A multi-building network is the same as a single building network except for the following: 
 

• An MQTT broker must be located in (or available to) every building. This broker is 
used to keep communication necessary within the building...in the building. This 
broker will be setup as a bridge broker to the main MQTT broker 
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Virtualization 
Roles & Responsibilities 
Specific to virtualized environments, the roles and responsibilities are split between 
Leviton & the site IT team. 
 

• Leviton 
o Commissions the control systems per the contract documents 
o Connects the control systems to My Building 
o Provides training on how to use the system to the end users 
o Provides My Building software and installation instructions to the IT team 
o Provides phone, email, and community support services 
o Provides Remote Support if remote access is provided 
o Provides Dev Ops support if purchased 

• Site IT Team 
o Provides hardware for installation of My Building 
o Defines specific My Building architecture 
o Executes all required network configuration 
o Installs My Building software 
o Performs all system upgrades 

 

Understanding Virtualization 
A virtual server is a software-based server that mimics the functionality of a physical server 
by partitioning a physical server into smaller, self-contained computer platforms. Virtual 
servers are often located in a cloud environment or off-site data center. There are several 
benefits to virtualization, and, the industry is ripe with broad and differing options on the 
topic, however, some of the key benefits are: 
 

• No dependency on physical hardware 
• No single point of failure 
• Ability to scale computing resources based on needs - static or dynamic 
• Build-in redundance 
• Centralized backup & management 
• Increased security 
• Lower total cost of ownership 
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The diagram below shows a rudimentary representation of what server virtualization looks 
like: 
 

 

 
Effectively, in this diagram: 
 

• Hardware: There are two physical pieces of hardware. In a virtualized environment 
we call these "Host Machines" and typically would have lots of process, memory, or 
storage capabilities. 

• Sever Manger: This is the devices which is responsible for managed the hardware, 
where, and how the virtual machines are deployed 

• Network: These are the clients and devices that interact with the virtual machines. 

The sever manager and Virtual Machine network is on a private and every secure network 
with very strict firewall and routing rules defining how and what get's access into and out of 
the network. Further, the virtual servers are fully isolated from each other and the only 
means by which they can communicate to each other is through the internal or external 
network which is also protected by routers and firewalls. In a VM world the rule is that there 
is no communication or access unless it's specifically and intentionally configured. 
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Operating System Requirements 
My Building will operate in any environment that runs Linux containers (aka docker 
containers.) Leviton has tested and offers, for fee, dev ops support services, for My Building 
under Windows Server 2022 or later, Windows 10 Pro, and Ubuntu Linux.. As such, any of 
these environments are suitable for the installation and your preference of OS. 
 

Note: 

• When installing on all platforms, our installations include Rancher & k3s except for 
servers which are BACnet only which run containerd and docker usually on Linux. 
Other architectures are supported but require local IT team support. 

• When installing on Microsoft platforms, containers are not natively supported in 
production environments. That said, many people choose to do it anyway. A 
solution for auto-start of containers is required; auto-login+lock is most commonly 
used for this purpose. 

• If BACnet is required, Microsoft has a bug passing UDP data between the container 
host and the container itself. IF this is required, local IT team support will be 
required to implement a solution. 
 

Storage Space Requirements 
Leviton recommends 1TB available for application and storage which will cover most 
system sizes. However, for systems of < 300 rooms, 250GB is sufficient to get started and 
then monitor consumption over time. The amount of required space will vary greatly based 
on the quantity of rooms, number of devices installed per room, the type of information 
that is being stored, and retention policies in place. 
 

• ~ 6GB Staging directory and image storage 

• ~ 30GB Database & File Storage for moderate sizes installation 

o Based on retention policies, storage requirements will grow over time and 
vary significantly based on the size of the project 
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IT Communication 

My Building communicates between software modules, the network, and other Leviton 
equipment on the IP network. Most of this communication is TCP/IP communication, 
however, some of it is UDP/IP. This article document what type of communication is 
required between various parts of the system, it's orgin, and it's destination. This will help 
you to create the appropriate firewall and routing rules to have a successful network 
deployment. 
 
The Ports List 
My Building uses the following ports for communication between various devices in the 
system. Device layout is documented in My Building System Architecture, only summary 
information is provided herein: 

 
 
 

https://communities.leviton.com/threads/my-building-system-architecture.57/
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BACnet 

If your project requires BACnet communication, which is often used to exchange sensor data 
with the BAS/BMS system and or allow the BAS/BMS system to control the lighting system, 
it will use either the BACnet/IP or BACnet/SC protocol. Which one is required is determined 
by your BAS/BMS system provider as that is the system to which we are interfacing. 
BACnet/IP is a UDP protocol that operates on Port 45808 and as such requires local access 
to the BAS/BMS. If local access is not possible, the BACnet/BBMD protocol can be 
implemented which in effect creates a UDP<->TCP/IP gateway for only BACnet data. This 
will need to be coordinated with the Leviton Field Tech and the BAS/BMS provider. A newer 
BACnet protocol referred to as BACnet/SC is also supported by our systems. This protocol 
uses TCP also on port 45808 and uses TLS for communication. BACnet/SC is only usable in 
your system if supported by your BAS/BMS provider. 

Remote & Internet Access 
Remote access is never required permanently. The system will operate fully standalone in a 
completely isolated environment. However, remote access can be a useful way to improve 
experience for the following: 
 

• Internet Access - useful to download My Building updates, device firmware, device 
definitions, and related information from the public My Building.Leviton.com server. 
If internet access is not available, information can be transferred via USB or other 
means. 

• Certificates - the system supports both user installed and Let's Encrypt certificates 
with auto-renewal. Internet access is required for auto-renewal. 

• Dev ops Support - if you purchased dev ops support as part of your package, full 
"root" / administrator privileges with remote access to the computer is 
required during the installation and roll out period 

• Remote Support - if remote support is needed by our team, remote access during 
the support exchange can be useful to aid in troubleshooting as it offers a 
streamlined experience with both parties looking at the same data. 
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Deploying a Leviton My Building Computer – 
Coordinating with IT 
Congratulations! You have a "customer hosted" version of My Building that is provided on a 
Leviton supplied computer. Integrating this into your system will be performed by Leviton's 
Field Service team however there are some options with respect to how it's tied into your 
system (aka Customer Network or Customer). 

 
Deployment Options 
Option 1 - Fully Isolated 
In this deployment the lighting control network is fully isolated from the Customer. This 
means that from the Customer network you can access the My Building software, both 
from the app and from the web UI, however, you can not access to the room controllers 
directly. This means you can do most activities, however, there are some you are restricted 
from, ex: device enrollment. To do device enrollment, you would have to connect directly to 
the lighting control network. 
 
To physically connect to My Building in this scenario, you will be connecting to the 
secondary Ethernet port of the server running the My Building software. 
 
Option 2 - Fully Integrated 
In the fully integrated solution, the lighting control network is a native part of the 
Customer's network. It may be on a different VLAN, however, all routing, access, and like is 
controlled by the Customer. 
 
To physically connect to My Building in this scenario, the customer will be connecting into 
the LAN side of the lighting control network. The secondary port of the computer with the 
My Building software will not be used. 
 
Information Required from Customer IT 

1. Preferred host name of the computer hosting My Building software. In absentia of 
any specific requirement, it will default to My Building. 

2. Regardless of Option 1 or Option 2, you need to know what IP address to assign to 
the Ethernet port. In some cases, the customer may want the MAC address of the 
port so they can assign it a static address in their system. The MAC address can be 
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located in the windows GUI or using ipconfig from a command prompt. On a Linux 
machine, use ifconfig. 

3. My Building software requires a mail server for sending periodic emails. We support 
only SMTP servers authenticated via username and password. 

4. SSID & Passphrase to which the room controllers can communicate 

Single Sign On (SSO) 
My Building supports Single Sign On (SSO) in a variety of ways. This article discusses how 
SSO is used in your projects. There are some key differences in the SSO implication based 
on whether you are hosting the My Building Application yourself (Customer Hosted) or 
Leviton is hosting My Building for you (Managed Hosting). 
 
Authentication Methods 
My Building supports several different style of authentication, not all are available with 
every hosting scenario, for background, all methods are as follows: 
 

• Email/Password - My Building uses your email to uniquely identify you and 
authenticates you with a password. The password is stored in a secured database 
on the My Building Server. Emails are validated prior to completion of account 
setup. 

• SSO, Google, Public - Google Public servers are used for authenticating using your 
gmail email address. Multi-factor authentication (MFA) is used if it supported as 
described through your google account 

• SSO, Microsoft, Public - Microsoft sever is used for authentication using the 
provided email address. Multi-factor authentication (MFA) is used if it supported as 
described through your google account. 

• SSO, Apple, Public - Apple servers are used for authentication using your Apple 
credentials. Multi-factor authentication (MFA) is used if it supported as described 
through your google account. 

• SSO, Microsoft, Private - Microsoft Active Directory Servers are used for 
authentication. The specific terms for allowed email addresses and MFA are defined 
by your organization. 
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• SSO, Google, Private - Microsoft Active Directory Servers are used for 
authentication. The specific terms for allowed email addresses and MFA are defined 
by your organization. 

 
Authentication Methods/Hosting Matrix 
Based on your hosting method, different authentication modes may be used based on how 
your system is configured. The matrix below identifies all possibilities. In addition, 
difference between the My Building App and the web browser App (Web App) are identified 
as necessary. 
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My Building Mobile App User Manual 
Domain Selection 
When first launching the My Building mobile app, the Domain screen will be shown. My 
Building installations can connect to either a Leviton Hosted Service (LHS) or a Customer 
Hosted Service (CHS) 

• The Leviton Hosted Service (LHS) is a hosting service that is managed and 
maintained by Leviton Manufacturing, Inc. 

• The Customer Hosted Service (CHS) is a hosting service that is managed and 
maintained by the end user. 

Select Domain 
The Leviton Hosted Service (LHS) will be selected by default. If another domain would like 
to be used, select the “Add Domain” option and enter the URL for the desired Domain.  
Select the “Connect” button to sync to the Domain. This process will take a few minutes. 
Select “OKAY” once the sync has completed. 
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Login 
A My Building account is needed to 
login into the My Building app. If 
you do not have an account, select 
“Create Account” and follow the 
prompts to create one.  

 

Enter Email 
If you already have a My Building 
account, enter the email 
associated with the My Building 
account and select “Continue.” 

 

 

 

 

 

 

Enter Password 
Enter the password for the My 
Building account and select “Sign 
In.” 

 

Forgot Password 
In the event the password is 
forgotten, enter the associated 
email address and select 
“Continue.” Then select the 
“Forgot Password?” link. Enter the 
email address again and select 
“Reset Password” to receive an 
email with a new temporary 
password. 
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Home Page 

After successfully logging in, the 
My Building app will show the 
Home Page, where the Projects 
overview screen is shown. Here a 
list of Projects can be viewed, 
Firmware updates can be 
downloaded, and Alarms, as well 
as the Project’s Profile can be 
viewed/edited. 

 
Connection Status 
Connection status can be seen in 
the top right of the Home Page. The 
app will show a colored square 
and a description of the 
connection. 

The following Connections may be 
shown: 

Server Connected 

Mode 1: Access Point or AP Mode 

Mode 2: Client Mode 

Mode 3: Connected to My Building 
Server 
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Project Management 
A list of Projects the My Building 
account has access to are shown 
on the Projects overview screen. 
Projects can be searched by name 
using the Search Bar on the top of 
the screen. 

 

 

 

 

 

 

 

 

 

 

Creating a New Project 

To create a new project, select the 
+ button in the bottom right of the 
screen. Enter the Project Name, a 
Description if desired, and 
Location details. Location details 
can be manually entered or 
automatically populated using the 
mobile device’s location by 
selecting the “Use my Location” 
button. Select “Save” to create the 
new Project. 
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Editing a Project 
Once a project has been created, 
it’s details can be edited by 
selecting the 3 dots to the right of 
the Project name. To edit the 
Project Name, Description, or 
Location, select the “Edit” option. 
The Project can also be Deleted as 
well as marked as a Favorite in this 
menu. Up to 5 Favorite Projects 
can be designated to display at the 
top of the Project list. 

 

 

 

 

 

 

Firmware Management 

Firmware can be downloaded by 
selecting the “Download” button 
shown in the top right corner of the 
Home Page. After selecting the 
“Download” button, the Firmware 
Management screen will be 
shown. 

 

Note: Firmware must first be downloaded 
on the Home Page but is then updated 
within the Node shown later in this 
manual. Refer to the “Node Room Tabs” 
section for more info.  
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Search and Filter 
Firmware versions can be 
searched and filtered by using the 
Search Bar or selecting the Filter 
button toward the top of the 
screen. Filter options are shown in 
the screenshot to the right. 

 

 

 

 

 

 

 

Downloading Firmware 
Select the Firmware that needs to be downloaded. Review the details to ensure the 
appropriate Firmware version is being downloaded for the devices. Selecting the 
“Download Now” button will download and store the firmware to the mobile device. Once 
the Firmware has been downloaded, select the “Ok” button. 

  



21 
Rev2 May 2026 

Downloading Older Firmware Versions 
Older versions may also be 
downloaded by selecting the 
Download button next to the older 
version. They can be deleted from 
the mobile device by selecting the 
red Trash Can button. 

 
Note: For Customer Hosted Solutions 
(CHS), Firmware must be manually 
loaded on the server before it is available 
on the My Building mobile app. 

 

 

 

 

 

Alarms  

The Alarms Page tab is shown in the 
bottom center and shows a list of Alarms. 
Alarms can be searched or filtered by 
using the Search Bar or by selecting the 
Filter button toward the top of the page. 
Filter options are shown in the screenshot 
below. Alarms can only be viewed in the 
My Building mobile app and must be 
created or modified on the Building Web 
App. 

  



22 
Rev2 May 2026 

Profile Page 

The Profile Page tab is shown in the bottom right of the My Building app. This page shows 
Account info, Language selection, Terms and Support, and Diagnostic options. 

 
Account 
My Building account profile details such as Name, Phone Number, Company Name, and 
Address can be edited using the Edit profile option. 

The account password can be changed by using the “Change password” option and the 
user account can also be logged out in this menu. 

Preferences 
The My Building app Language can be set in this menu. English is currently the only 
supported language. 

Terms and Support 
Terms of Service and Privacy documents can be viewed here as well as Tech Support 
contact information. The Help option provides a link to My Building FAQs, found on the My 
Building website; user account login is required to view the FAQ section. 
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Diagnostic Options 
A list of Sync Logs files can be viewed by selecting the “Sync Logs” option. 

Nodes can be updated by selecting the arrow next to the “Update Nodes” option. 

App Logs can be cleared by selecting the arrow next to “Clear App Logs.” 

Server Override 
This option should not be used unless instructed by an authorized Leviton representative. 

Accessing a Project 

Click on a Project from the Projects overview list to access the Project. This page shows the 
Project Status, All Nodes, and Users tabs as well as a Project Hierarchy Tree (left side). 
When first accessing a Project, the Status Page is shown. 

Status Page 

The Status Page shows total number of Online/Offline devices (if networked), 
Instantaneous Reactive Power (if available), and Instantaneous Energy Usage (if available) 
for the selected Project. 
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The three dots in the top right corner of the page provide similar options as the three dots in 
the previous Projects overview page. Project info can be viewed/edited, the Project can be 
Deleted and Selected or Removed as a Favorite. Two additional options are also available: 
Project Hierarchy and Sync. 

The Project Hierarchy Tree option is the same as the icon on the left of the screen. 

The Sync option forces a sync to the Project’s Domain/Cloud Server. 
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All Nodes 

The All Nodes Page shows a list of Nodes created in the Project. Node types can be 
Country, Region, State or Province, City or Town, Interior Lighting, Exterior Lighting, Plug 
Load, HVAC Load, Building, Floor, Area, Room, and Hard Room. 

Nodes types such as Country, Interior Lighting, or Floor are intended to help organize a 
project into different categories. 

A GreenMAX DRC Room Controller can only be associated to a “Room” Node. 

Utilizing different Node types is left to the discretion of the individual commissioning the  
Project. 

Nodes can be Searched using the Search Bar located on the top of the page. 

Adding a New Node or Room 
To add a new Node or Room for association to a GreenMAX DRC Room Controller, select 
your Project and navigate to the All Nodes tab. Select the Plus Symbol in the top right 
corner. Enter your Node or Room Name, select “Room” as Node Type, and a description of 
the Node or Room if desired. Select the “Use my location” button to autofill the Latitude, 
Longitude, Altitude, and Timezone values or enter them manually. 
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Once a Node or Room has been created, it will appear in the “All Nodes” list. Note that a 
new Node that has not been associated to a GreenMAX DRC Room Controller has 3D box 
symbol. Once the Node is associated with a Room Controller, the symbol will turn into a 
shaded plus symbol as shown below. 

 

         Associated  -> 
 
Not Associated  -> 

 

 

 

 

 

 

 

 

Selecting the three dots next to the Node 
reveals Edit, Delete, and Project 
Hierarchy options for that Node. 
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Associating a GreenMAX DRC Room Controller to a Node 
Once a Node or Room has been created. Select it from the All Nodes list and select the 
“Associate room controller” button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the connection method. Room Controllers can be associated via QR Code or via Wi-
Fi. To associate a Room Controller via Wi-Fi, select “Associate via Other Methods”, then 
“Wifi” and “Continue” 

When using the QR method, you may need to enable the device’s camera for the My 
Building app. Follow the prompts on the device’s screen to allow access to the camera. 

Scan the QR code on the GreenMAX DRC Room Controller and wait for the app to 
associate the new Room Controller to the Node. 
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When using the Wifi option, the app will open the device’s Wi-Fi Settings to select the 
GreenMAX DRC Room Controller’s Wi-Fi network. The Room Controller will have a default 
network name (SSID) ending in the Room Controller’s ID; GreenMAX DRC-39E9, 39E9 being 
unique to each Room Controller. The default SSID password is “leviton0000” without 
quotes. Once the device is connected to the Room Controller’s Wi-Fi, navigate back to the 
My Building App and wait for the app to associate the Room Controller to the Node. 

GreenMAX DRC Room Controller Default SSID Info: 

SSID: GreenMAX DRC-39E9, 39E9 being unique for each Room Controller 

Password: leviton0000 

Once the Room Controller has been associated with the Node, the Room Controller will be 
assigned a new Wi-Fi network name, matching the Node name entered in the app. The app 
will prompt you to reconnect to the new Room Controller’s network or SSID (left 
screenshot below). After selecting OK, the app will redirect you to the device’s Wi-Fi 
Settings app to select the new network name. Select the new network name and navigate 
back to the My Building app where it will attempt a connection to the new network SSID 
(shown in the right screenshot below). 
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Users 

The Users Page shows a list of all Users added to a Project. The Project Admin is 
automatically assigned to the account that initially created the Project. Additional Users 
can be added to the project using the + button located in the top right. The following User 
Roles can be assigned to each new User; Room User, New Regression Role, Project Admin, 
and Public Display. There is no limit to the amount of Users that can be added to a Project. 
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Creating a New User 
To create a new User, select the + symbol 
in the top right of the page. Enter the new 
User’s email address, select a role, and 
select Invite on the bottom of the page. A 
message will pop up on the screen that 
indicates a notification has been sent to 
the User. Select “Ok”, got it to proceed. 

Roles: 

Room User 

New Regression Role 

Project Admin 

Public Display 

 

 

 

 

The new User will receive 
an Invitation email asking 
them to Accept the 
Invitation & Register an 
Account if they do not 
already have one. If the 
User does not receive an 
Invitation email, double 
check that the email 
address was entered 
correctly and have the user 
check their Spam folder. 
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Changing a User’s Role 
To change a User’s Role, the User must be removed from the account using the steps 
below, then re-added using the steps detailed above. 

Deleting a User 
To remove a User from the Project, select the three dots to the right of the User’s name. 
Then select Remove User Association. A pop up will appear asking for confirmation. Select 
“Delete” to remove the User from the Project. 
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Node Tabs – Room 

After associating a GreenMAX DRC Room 
Controller to a Room Node, the Status 
page will be displayed by default. The top 
of the screen shows the following tabs; 
Status, Breakout Rooms, Devices, 
Settings, Daylighting Zones, Occupancy 
Zones, Schedules, and Users. The three 
dots in the top right corner provide 
options for Edit, Delete, Project Hierarchy,  
Firmware Updates, Sync, End Node 
Firmware Update, Reboot Controller, and 
Send Logs (scroll up for last two options). 

 

 

 

 

 

 

Editing  a Node 
To Edit an existing Node, select the three 
dots in the top corner of the Node. The 
“Edit” option can be selected from the 
three dots menu in the Node List menu 
(next to the Node) or within the Node 
itself (top corner).  

The following parameters are editable: 

Node Name 

Location Latitude, Longitude, Altitude, 
and Time zone.  
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Deleting a Node 
Deleting a Node is similar to Editing a 
Node. To Delete an existing Node, select 
the three dots in the top corner of the 
Node. The “Delete” option can be 
selected from the three dots menu in the 
Node List menu (next to the Node) or 
within the Node itself (top corner).  

Select “Delete” to delete to Node. The 
app will provide a confirmation the Node 
has been deleted. 

 

 

 

 

 

 

Node and End Node Firmware Updates 
Firmware updates must first be downloaded on the Home Page. Refer to the earlier section 
“Firmware Management” and “Downloading Firmware” for more info on downloading the 
latest firmware. Once the latest firmware has been downloaded into the app, selecting 
“Firmware Updates” or “End Node Firmware Updates” begins a query to check for available 
device updates. If an update is available, select the “Deploy” option to begin the update 
process. Depending on the device, this can take anywhere from under a minute to several 
minutes.  

Syncing a Node 
The “Syncing a Node” option syncs the app’s current configuration with the My Building 
server. Once selected, the app will attempt to sync with the My Building server and provide 
confirmation whether it was successful or not. 

Reboot Controller 
The GreenMAX DRC Room Controller can be rebooted by selecting this option. It can take a 
couple minutes for the Room Controller to reboot and restore all functionality. 
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Send Logs 
If instructed by Tech Support or a Leviton Representative, this option is used to send logs 
for diagnostic review. After the Controller Logs are prepared, a CSV file will be generated. 
Follow the prompts on the mobile device to save the CSV file to the device for later use or 
send the CSV file via email, etc. 

Status Tab 
The Status page shows the Room Controller’s number of Devices Online/Offline, Daylight, 
Occupancy, and Instantaneous Energy Usage status (if available) as well as Scenes and 
Groups for the connected Room Controller. 

 

 

Creating a Scene or Group 
To create or edit a Scene or Group, select 
the drop-down arrow next to Scenes or 
Groups. Once the app has finished 
fetching data, select the + symbol to add 
a new Scene or Group or the “Gear 
Wheel” icon to edit an existing Scene or 
Group. 

 

Note: Groups are required to configure 
Scenes. Groups must first be created 
before they can be added to Scenes! 
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For Scenes, enter a Name for the Scene, select its Fade Time settings, and add Scene 
Members or Groups for control. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once Groups have been selected, the 
app provides a live screen to configure 
Scenes. Dragging the slider will change 
the light level in real time for the selected 
Scene Member/Group. 

 

Once changes have been made, select 
“Update” to save. 
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For Groups, enter a Name for the Group and add Devices by selecting the + symbol.  

Once changes have been made, select “Save”. 
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Deleting a Scene or Group 
To Delete a Scene, select the Scene you   
wish to delete, then select the “Delete” 
option on the bottom of the page. 

 

 

 

 

 

 

To Delete a Group, select the three dots 
next to the Group you wish to delete and 
select the “Delete” option. 

 

 

Breakout Rooms Tab 
Breakout Rooms is not currently supported but will be supported in future app releases. 
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Devices Tab 
The Devices tab lists all enrolled devices 
for the connected Room Controller. 
Device types can be Digital 
Occupancy/Photocell Sensors, Analog 
Input Boards, Multi Channel Relays, 
Phase Cut Dimmers, Smart Packs, 
Switches, and Touchscreens. Devices 
such as power supplies (DRC00-
0D0/DRC10-0D0, DRAD0-PIN, etc) do not 
show up in this list and are not 
configurable. 

 

 

 

 

 

 

 

Adding a Device 
To add a Device, select the + symbol 
toward the top right. Devices can be 
added via QR Code or by scanning the 
LumaCAN network. 
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When using the QR Code method, scan the device’s QR Code and wait for the app to add 
the new device. 

When using the Associate via Other Methods option, select “LumaCAN” from the drop 
down menu to scan for available devices on the LumaCAN network. 

After adding a device, enter a name if desired then select “Enroll.” 
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The app will provide a Success prompt 
after successfully adding a new device. 
Select “Ok” to proceed. 

 

 

 

 

 

 

 

 

Once a new device has been enrolled, the app will ask the user if the new devices need to 
be added to any Groups/Zones. New devices can be added to existing Groups/Zones or 
placed into a newly created Group/Zone. 
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After adding a new device, selecting the 
device in the Devices list will allow the 
user to view Status and edit its Properties. 
Depending on the device, there can be 
several different properties to configure. 
Below are some screenshots of various 
devices. Note that the default tab is the 
Status tab; to configure Properties, select 
the Properties tab. Not all devices show 
Status. 
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Identifying a Device 
The My Building app provides users with the ability to Identify devices by flashing its LEDs 
or connected load. For devices such as switches and sensors, the LEDs on the device will 
flash to indicate they are in Identify mode. For load devices, such as Smart Packs or Multi 
Channel Relays, the connected loads will turn on/off and dim up/down if capable. 

Devices can be individually Identified by selecting the green symbol with a question mark 
next to the device. The option to Identify all devices is also provided at the top of the 
screen. 

The device will continue to Identify until the Identify symbol is pressed again.  
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Deleting a Device 
To delete a Device, select the Trash Can symbol next to the Device you want to delete. Then 
select “Delete” to confirm. 
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Settings Tab 
The Settings tab shows the Room Controller’s Auto-Configuration, Network, and Time 
properties. The Room Controller is in Access Point or AP Mode by default. However the 
Room Controller can also be connected as a Client to the site’s Wi-Fi. 

 

Auto-Configuration 
Auto-Configuration allows the Room Controller to assign LumaCAN addresses to each 
LumaCAN device on the network. Auto-Configuration can be enabled or disabled via the 
toggle on the Network Properties section of the Settings tab. 

Access Point vs Client Mode 
A GreenMAX DRC Room Controller’s factory default is Access Point or AP Mode. In this 
Mode, the Room Controller behaves like an Access Point and allows for a direct connection 
to the My Building app. The Room Controller can also be connected to a local Wi-Fi 
network to access over the network or remotely. This Mode is called Client Mode. 

Client Mode can be enabled by selecting the “Edit” button, in the Network Properties 
section of the Settings tab. Select the magnifying glass symbol toward the right of the SSID 
field to scan for available nearby Wi-Fi networks. Select the desired Wi-Fi network and 
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enter the network’s password. In most cases, DHCP should be left enabled; work with the 
site’s IT department to determine if DHCP or a Static IP address will be used. The Wi-Fi 
channel can also be selected on this page. Once the Wi-Fi settings have been configured, 
select “Update.” 
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Time Properties 
The Room Controller’s time and date can 
be synchronized to a NTP server if 
available, synced with the mobile device 
used for commissioning, or manually 
configured. This section allows the user 
to change date and time, Daylight 
Savings, Astronomical Time, and NTP 
server settings (if applicable). 

 

Synchronize Node Settings - Synchronizes 
all time and location settings from mobile 
device.  
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Daylighting Zones 
The Daylighting Zones tab shows all 
currently configured Daylight Zones with 
the ability to create, edit, and delete 
Zones. Each Zone will display its Status, 
Current Light Level, and Target Light 
Level. 

 

 

 

 

 

 

 

 

 

 

 

 

Adding a New Daylight Zone 
To add a new Daylight Zone, select the 
white/blue + symbol toward the top right.  

Enter a Name for the Daylight Zone. 
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Add Devices by selecting the black + 
symbol. 

Select your desired Devices and select 
Add. 

 

 

 

 

 

 

 

 

Select the Zone Type, Primary or 
Secondary and Cap Target or Override. 
Enter your desired settings. 

A Primary or Secondary Daylight Zone can 
be defined. 

The zone can be set to Cap Target or 
Override. Cap target prevents the light 
level from rising above the defined light 
level. Override allows the occupants to 
temporarily override the light level for a 
defined period. Refer to local energy 
codes when configuring this option to 
ensure compliance. 

 

Select “Save” to create the Daylight Zone. 
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Edit a Daylight Zone 
To edit a Daylight Zone, select the gear icon to the right of the Daylight Zone. In the pop up 
menu, select “Edit.” Once the desired changes have been made, select Update at the 
bottom of the page. 

       

 

Delete a Daylight zone 
Deleting a Daylight Zone can be done in 
two places. The first option is in the pop 
up menu when selecting the gear icon 
next to the Daylight Zone. The second 
option is in the zone itself, after selecting 
“Edit.” After selecting either option, the 
app will ask to confirm deleting the Zone 
and provide a “Success” prompt after 
successfully deleting the Zone. 
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Identifying a Daylight Zone 
To Identify a Daylight Zone, select the green symbol with a question mark to the right of the 
Daylight Zone. The luminaires tied to the selected Zone will dim up and down as well as 
turn off and on. Identify will continue to cycle luminaires until the Identify button is pressed 
again or the My Building app is disconnected from the Room Controller. 

 
 

Occupancy Zones 
The Occupancy Zones tab shows all currently configured Occupancy Zones with the ability 
to create, edit and delete Occupancy Zones. Each Zone will display its occupancy Status. 
The steps to configure Occupancy Zones are very similar to configuring a Daylight Zone.  
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Adding a New Occupancy Zone 
To add a new Occupancy Zone, select the white/blue + symbol toward the top right.  

 

Enter a Name for the Occupancy Zone. 

Add Devices to the Zone by selecting the 
black + symbol. 

Make sure the “Zone enabled” toggle is 
enabled. 

Select an action from the drop down 
menu: Restore Last Level, Go To Fixed 
Level, Manual On, or Restore Scene. 
Upon occupancy detection, the lights will 
execute this action. 

Enter values for desired Primary and 
Secondary Timeouts. Level is on a scale 
from 0-255; for example 128 is about 50% 
dim level. Secondary Timeout provides 
the occupants in the space with a 
warning period before lights shut off. It is 
recommended to have a longer Primary 
Timeout than Secondary. For example, if a 
15 minute timeout is desired, the Primary 
Timeout should be set to 13 minutes and 
the Secondary Timeout should be set to 2 
minutes. Once the room is unoccupied 
for 13 minutes, the lights will go to 50% 
dim level and after another 2 minutes, 
shut off to 0%. The 2 minute period where 
lights are dim provide a grace period for 
the occupant to retrigger the Occupancy 
Zone if desired. Upon reactivating the 
zone, the lights will go to their defined 
light level.  

Select “Save” to complete configuration. 
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Editing an Occupancy Zone 
To edit an Occupancy Zone, select the gear icon to the right of the Occupancy Zone. In the 
pop up menu, select “Edit.” Once the desired changes have been made, select “Update” at 
the bottom of the page. 

       

 

Deleting an Occupancy Zone 
Just like Daylight Zones, deleting an 
Occupancy Zone can be done in two 
places. The first option is in the pop up 
menu when selecting the gear icon next 
to the Occupancy Zone. The second 
option is in the zone itself, after selecting 
“Edit.” After selecting either option, the 
app will ask to confirm deleting the Zone 
and provide a “Success” prompt after 
successfully deleting the Zone. 
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Identifying an Occupancy Zone 
To Identify an Occupancy Zone, select the green symbol with a question mark to the right of 
the Occupancy Zone. The luminaires tied to the selected Zone will dim up and down (if 
capable) as well as turn off and on. Identify will continue to cycle luminaires until the 
Identify button is pressed again or the My Building app is disconnected from the Room 
Controller. 

 

 

Schedules 
Each GreenMAX DRC Room Controller can have its own local schedule as well as 
subscribe to Project schedules for central scheduling control. Scheduling is Event based 
and can be configured to manipulate Light and Behavior settings. 
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Creating a Schedule 
To create new schedule, select the + symbol towards the upper right, then “Add a new 
Schedule.” Enter a Name for the Schedule and select the Type. 

Project Schedules: Project schedules can be created aa a master or central schedule for 
other Room Controllers to subscribe to. This allows for simple schedule control in one 
Room Controller rather than having to create and maintain separate schedules in individual 
Room Controllers. 

Local Schedules: Local schedules only control the devices enrolled within Room Controller 
that is currently connected to. 
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Creating Events 
After naming a Schedule, each schedule 
must have an Event configured. Select 
the + symbol to the right of Schedule 
Events (refer to previous screenshot). 
Enter a name for the Schedule Event and 
select/configure Light and/or Behavior 
settings. 

 

 

 

 

 

 

Configurable Light and Behavior Settings 
The screenshots below show the different Light and Behavior settings that can be 
scheduled. Once all parameters have been configured, select “Save” to create the 
Schedule Event. 
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Save the Schedule 
Once the Schedule Events have been created, select “Save” to create the Schedule and 
push it to the Room Controller. Ensure the Time, Date, and Location settings are properly 
set on the Room Controller’s Settings Tab, under the Time Properties section. 
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My Building Web App User Manual 
My Building can be accessed through any Web Browser to view, configure and monitor your 
system. The majority of configuration is completed through the My Building Mobile App 
however some settings such as occupancy zone settings and schedules can be 
manipulated through the Web App if a My Building server is deployed and configured 
properly. 
 

Logging in 
The same user account used for the My Building Mobile App is used to log into the My 
Building Web App. If an account has not been created yet, a new account can be created 
on the log in page by selecting the “Sign Up” link. Othwerwise, user your existing Username 
and Password to log into the Web App. 
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Navigation Bar 
The Navigation Bar is available at the top of all pages and can be used to quickly view 
different areas of the My Building platform. 

 

 

Home Page 
Any Project or Dashboard can be set as the Home Page but only one Project or Dashboard 
may be set as the Home Page at a time. By default, the Home Page is not configured. 

 
Default Home Page, no Project set as Home Page 
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Tree View 
The Tree View tab provides a high level overview of all Projects currently assigned to the 
logged in User. Favorites will appear at the top of the menu and all Projects can be viewed 
by selecting the “View All Projects” option. Below is a screenshot of the View All Projects 
page. 
 
 

 

 

 

 

 

 

 

 

Dashboards 
The Dashboards tab lists all available Dashboards for the logged in User. Dashboards are 
customizable and various Widgets can be added for reporting. Dashboards can also be set 
as the Home Page using the three dots menu. 
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Creating a Dashboard 
To create a Dashboard, select the “+ New Dashboard” button toward the upper right corner. 
A new window will display on the right of the screen. Enter a Dashboard Name and select 
the Security type. A description and Thumbnail/Picture may also be uploaded to the 
Dashboard. Select “Save” to create the new Dashboard. 

 

 

 

Dashboards Options Menu 
The three dots menu to the right of the 
Dashboard provides various options for 
management and sharing.  
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Managing Widgets 
Adding a Widget, Step 1 
Once a new Dashboard has been created, 
you will be brought to the Edit Widgets 
page. Here you can Add, Edit, and Delete 
Widgets.  

If you are adding Widgets to an existing 
Dashboard, there are two ways to Edit 
Widgets. Selecting the three dots menu 
next to the Dashboard on the Dashboard 
page or within the Dashboard itself 
reveals the option “Edit Widgets.” 

 

 

 

 

 

 

 

 

To add Widgets, select the “+ Add Widget” 
option. 

A new window will appear on the right of 
the screen. Select the desired Widget, 
then select “Continue” on the bottom of 
the screen. You may need to scroll down 
to see the Continue option.  
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Configure the Widget, Step 2 
The next step is to configure the Widget. 
Each Widget has its own set of properties 
to configure. The screenshot to the right 
shows the Energy Report Widget. All 
Widgets have the option to select the 
Project and Node to report as well as the 
Refresh Interval but may also include 
other options such as Start and End date 
or Display type. 

Once all parameters have been 
configured, select the “Add” button to 
add the Widget to the Dashboard. 

 

Exit Edit Widgets View 
After making changes to Widgets, exit the 
Edit Widget view by selecting “Done” in 
the top right corner. 
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Edit A Widget 
To Edit an existing Widget, enable the Edit 
Widget View by selecting “Edit Widgets” 
from the options menu. Then select the 
Gear icon next to the Widget that needs to 
be edited as shown below. A new window 
will appear to the right, allowing changes 
to be made. Once desired changes have 
been made, select “Update” to save 
changes. 

 

 

 

 

 

 
 
 

Exit Edit Widgets View 
After making changes to Widgets, exit the 
Edit Widget view by selecting “Done” in 
the top right corner. 
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Delete a Widget 
A Widget can be Deleted by entering Edit 
Widget mode and selecting the Trash can 
symbol next to the Widget. 

A prompt will appear asking for 
confirmation. Select the “Delete” option 
to confirm and delete the Widget. 

 

 

Exit Edit Widgets View 
After making changes to Widgets, exit the 
Edit Widget view by selecting “Done” in 
the top right corner. 
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Manage 
The Manage tab provides the ability to View Users, Role Types, Alarms, and Firmware 
Management. These categories are not editable from the Manage tab and must be edited in 
the Project itself. Firmware must be deployed from within the Project as well. However 
Alarm Rules are configurable through this menu. Alarm Rules can be tied to specific 
Projects and Nodes or Rooms. 

 

Users 
The Users tab lists all Users for Projects assigned to the logged in User. User Roles and 
access are not edited in this menu view but be viewed. Modifications to User Roles must be 
done within the Project or Node. 
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Roles 
The Roles option lists all User Roles available in the system and their permissions. Roles 
cannot be edited in this menu view and are just listed for reference on this page. 

 

 

Alarms 
The Alarms option displays a list of all currently configured Alarms for all Projects assigned 
to the logged in User. Alarms cannot be edited in the menu view and are just listed for 
reference. 
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Firmware Management 
The Firmware Management options list all available firmware versions for the connected 
Projects and devices. Firmware cannot be deployed from the menu view and only listed for 
reference. Firmware must be deployed from within the Project or Node/Room. 

 

Alarm Rules 
Alarm Rules can be viewed, edited, and deleted from this menu view. 
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Adding a Project 
If a Project has not yet been created in the Mobile App, a new Project can be created by 
selecting the “Tree View” tab toward the top of the page then “View All Projects.” To create a 
new project, select the “+ Add Project” option. 
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A new pane will show up on the right side 
of the screen. Enter the required details 
and select “Save” to create a new project. 
If desired, the location details can be 
entered later using the Mobile App and 
syncing the details from the mobile 
device’s settings. 

 

 

 

 

 

 
 

 

Accessing a Project 
Once a Project has been assigned as a Home Page, the view for Home Page and selecting 
the Project from the Tree View tab will be the same. 

 

Hierarchy 
The left pane shows a hierarchy for the 
Project. Selecting the + symbol will 
expand the list to show all Nodes for the 
Project.  
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Status Page 
The Status Page shows total number of Online/Offline devices (if networked), 
Instantaneous Reactive Power (if available), and Instantaneous Energy Usage (if available) 
for the selected Project. 

 

Uploading a Custom Project Image 
Each Project can have a unique image displayed on its Status page. Select the box with a 
pencil to upload a new image. Images must follow the guidelines detailed below. 
 
Image specs: 200x200 pixels (minimum) 
Format supported: JPG, PNG 
Size limit: 1 MB 
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Executing a Load Shed 
To execute a Load Shed command, select the “Execute Load Shed >” option on the Status 
Page of the Project. 

 

 

 

 

A new window will appear. Make the 
selection for level and select “Execute” to 
send the command to the Project and 
connected devices. Load Shed 
parameters must be configured on each 
GreenMAX DRC Room Controller as well 
as networked to the My Building Server. 
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Project Options Menu 
The Options Menu can be accessed by selecting the three dots toward the top right of the 
Project Page. This menu is available at any time within the Project. 
 

 
 

 

 

Editing Project Details 
Selecting the Edit option allows a user to 
change the Project Name, Description, 
and Location information. Project 
Number is system generated and cannot 
be changed. This menu also provides the 
ability to subscribe to Utility Companies 
for up-to-date Rate data. Once the 
desired changed have been made, select 
“Update” to save. 
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Subscribing to a Utility 
To subscribe to a Utility for up-to-date Rate data, select the “+ Add Subscription” option in 
the Edit menu. Select your Type and search for the name of your Utility Company by using 
the Search By options. Once your Utility and subscription have been selected, select “Add” 
to create the subscription. 
 

 
 

Deleting a Project 
To delete a Project, select “Delete” from the Options menu. A prompt will display in the 
center of the screen asking for confirmation. Select “Delete” once more to confirm deletion 
of the Project. 
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Setting a Project or Dashboard as the Home Page 
To set a Project or Dashboard as the Home Page, first select the Project or Dashboard you 
wish to use from the appropriate page. Then select “Set as HomePage” from the Options 
menu a shown below. 
 

 
Project Example 
 

 
Home Page set to Executive Suite Lab Project 
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Export Project Data 
Project data can be exported using the “Export Project Data” option. A new window will 
appear in the center of the screen. Select the items to be backed up and exported, then 
select “Export.” Once the files have been generated, they will automatically download 
through the Web Browser. 
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Marking a Project as a Favorite 
Up to 5 Projects can be marked as a 
favorite. Marking a Project as a Favorite 
will list the Project first on the Projects 
overview page. 

 

Adding a Favorite Project 
To mark a Project as a Favorite, select the 
STAR symbol toward the upper right 
corner of the Project. A Project can also 
be marked as a Favorite by selecting “Add 
to favorites”  option on the Projects 
overview page. Select the three dots next 
to the Project name, then select “Add to 
favorites” from the menu. 

 

 

 

Deleting a Favorite Project 
Deleting a Project as a 
Favorite is the same as 
adding a Favorite. Select 
the star symbol again or 
select “Remove from 
favorites” from the Project 
option menu. 
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All Nodes Tab 
The All Nodes tab shows all created Nodes within a Project. Nodes are used to help 
organize the Project with categories such as Location (Country, Region, etc), Area (Building, 
Floor, etc), or Type of Load (HVAC, Plug Load, Lighting, etc). It is up to the commissioner to 
determine how the Project is organized. Keep in mind User roles are tied to Node categories 
or hierarchy levels. 

 

Adding a Node 
To create a new Node, select the + symbol 
in the top right corner. A new window will 
appear on the right side of the screen.  

Enter a Node Name, select a Node Type, 
and enter the location details. Location 
details are optional but are required when 
using features such as Astronomical 
Timeclock. 

Location details can be added later using 
the My Building Mobile App and synced 
with the device’s GPS location for easier 
configuration. 

Select “Save” to create the new Node. 
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Node Options 
Once a Node has been created, the Options menu provides the ability to Edit, Delete, 
Move, or Upload a Picture for the Node.  

 

 

 

Editing a Node 
To Edit a Node, select the “Edit” option 
from the Options menu (three dots). A 
new window will appear on the right 
where the Node details can be modified. 

Once the desired changes have been 
made, select “Save” to save changes. 
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Deleting a Node 
To Delete a Node, select “Delete” from 
the Options menu (three dots). A new 
window will appear asking to confirm the 
action. Select “Delete” once more to 
delete the Node. 

 

Moving a Node 
Nodes can be moved to different 
hierarchy levels. To Move a Node, select 
“Move” from the Options menu (three 
dots). 

A new window will appear to the right. 
Select the hierarchy level to move the 
Node to. Then select “Move Node(s)” to 
move the Node to the selected level. 

 

Users 
Users can be managed from a Project level or Node level. Adding users to the Project level 
grants access to all Nodes within the Project. However User access may also be restricted 
to individual Nodes. 
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Managing Users 
Adding Users 
To Add a User to a Project or Node, select 
the + symbol in the upper right corner or 
the “+ Invite User” option in the User list. 
A new window will appear to the right of 
the screen. 

Enter an Email address or select one from 
the list by clicking on the Email Address 
menu (3 lines), choose a User Role and an 
Association. 

Select “Invite” to notify the User they have 
been added to the Project or Node. 

 

Deleting a User 
To Delete a User, select the Options menu (three dots) next to the User that needs to be 
deleted. Then select “Remove Association”  

 

 

A confirmation window will appear. Select “Remove Association” again to delete the User. 
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Schedules Tab 
Schedules at the Project level can only be viewed. Schedules can only be managed at the 
Room level. In this view, schedules can be viewed and filtered by Day, Week, or Month. 
Managing schedules will be explained later in this guide, within the Room Node. 

 

Events Tab 
The Events tab is similar to the Schedules tab. A list of upcoming Events are displayed in 
this list. 

 

 

 

 

 

 

 

 

 

 



82 
Rev2 May 2026 

Room Node 
The Room Node is the only Node type that can have a GreenMAX DRC Room Controller 
associated with the Node. Once a GreenMAX DRC Room Controller is associated with the 
Node and networked to the My Building server, it can be remotely configured and 
controlled. Not all configuration options are available on the Web App and some functions 
are only available on the My Building Mobile App. The majority of configurations are 
completed with the My Building Mobile App. Refer to the Mobile App User Manual for more 
information on associating and commissioning a Room Contoller. 

Status Tab 
The Status tab in the Room Node is identical to the Status Tab on the main Project level. 
Features such as the Option menu (three dots) and Executing Load Shed are the same and 
won’t be covered in this section. Refer to the previous Status tab section in this manual for 
more information on using these features. 
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Managing Scenes 
Scenes can be added, edited, deleted, and controlled by expanding the Scenes list. Use 
the arrow on the right to expand the Scenes list. 

 

Adding a Scene 
To add a new Scene, select the “+ Add/Create Scene” option. A new page is displayed. 
Enter the Scene Name and Fade Time Values. 

 

 

 

The next step for adding a Scene is to 
select its members. These are the Groups 
or Devices that will be controlled by the 
Scene. 

Check the desired Groups or Devices, 
then select “Add” to add the members to 
the Scene. 
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Once members have been added to the Scene, they will appear as sliders. Set the desired 
light level for each Group or Device. Then select “Save” in the upper right corner to create 
the Scene. 

Use the “Preview Scene” check box to see a live demonstration of the Scene in the space. 

 

 

Editing or Deleting a Scene 
Scenes can be edited or deleted by selecting the Gear icon in the right corner of the Scene.  
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Make the desired changes on the screen and select “Save” in the upper right corner to 
update the Scene. 

 

To Delete a Scene, select the “Delete Scene” option under the Fade Time settings. A 
confirmation window will appear. Select “Delete” again to confirm and delete the Scene. 

 

Controlling a Scene 
Scenes can also be controlled on the Status page. To execute a Scene, select “Execute” 
under the desired Scene. The Scene will immediately begin to adjust the lighting levels to 
the predefined values. 
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Managing Groups 
Groups can be added, edited, deleted, and controlled by expanding the Groups list. Use 
the arrow to the right to expand the Groups list. 

 

 

 

 

 

 

Adding a Group 
To add a new Group, select the “+ Add Group” option. A new pane is displayed to the right. 
Enter the Group Name and add Devices by using the “+Add” option. 

 

 

In the window that pops up, check the 
Devices that are to be included in the 
Group. 

Then select “Add.” 

 

 

 

 

 

Once a Name has been entered and 
members added to the Group, select 
“Save” to create the Group. 
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Editing a Group 
To Edit an existing Group, select the 
Options menu (three dots) next to the 
Group. 

Then select the “Edit” option. 

 

 

 

A new pane is displayed on the right. Add 
or remove Devices just like in the previous 
section. 

Then select “Update” to save changes. 
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Controlling a Group 
Groups can also be controlled from the Status page. To control a Group, select the Group 
from the Group list. 

Use the slider and adjust Fade Values to control the Group and connected lighting loads. 

Manipulating the slider will immediately send a command to the Group and its associated 
Devices. 
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Devices Tab 
The Devices tab lists all enrolled GreenMAX DRC Devices for the Room Node. Device status 
(if available) and settings can be viewed and edited on this tab. However Devices cannot be 
added or deleted from this tab. Adding or deleting Devices from the Room Controller can 
only be done in the My Building Mobile App. 
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Viewing a Device 
All Devices have unique properties that can be configured or monitored. Load devices such 
as Room Controllers and Smart packs can be controlled in addition to manipulating its 
properties. 

Below is an example of a Room Controller. Its connected load can be turned 
on/off/dimmed with the slider bar and Fade Values on the Status Page. 

 

 

Properties such as Device name, Channel Number, Trim Settings, and Demand Response 
values can be viewed and edited. These parameters will be unique to each Device type. 

Select the “Update” button in the top right to save any changes. 
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Applying Firmware to a Single Device 
Firmware can be applied at different levels for the entire Project or by Node. Selecting a 
Device in the Device List allows for individual updates. 

After selecting your desired Device, select the Options menu (three dots) in the upper right. 
Then select “Firmware Updates” 

 

 

A new pane will appear on the right, 
showing any available firmware updates. 
The newest updates are at the top of the 
list. Users also have the option to rollback 
firmware if needed. 

To apply firmware, select the “Deploy” 
option next to the desired version.  
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A new window will display. Select the 
Date and Time for deployment, then 
select “Deploy” to apply the firmware. 

 

 

 

 

 

Settings Tab 
The Settings tab shown in the Room Node is identical to the Settings tab in the My Building 
Mobile App. Network, Time/Date, and Location settings can be viewed and edited here.  

To edit Network or Time/Date/Location settings, select the box with a pencil. A new pane 
will appear on the right. Make the desired changes, the select “Update” to save any 
changes. 
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Daylighting and Occupancy Zones 
The process to add, edit, or delete Daylighting and Occupancy Zones is identical. The 
example below refers to a Daylighting Zone but is very similar for Occupancy Zones. 

Adding a Daylighting or Occupancy Zone 
To add a new Daylighting Zone, select the + symbol in the top right corner or the “+ Add 
Daylighting Zone” option in the list. A new pane will appear to the right. 

Enter a Name and select the desired Devices and properties for the Zone. Then select 
“Save” to create the new Daylighting Zone. 

 

Editing or Deleting a Daylighting Zone 
To Edit an existing Daylighting Zone, select the Gear icon next to the desired Daylighting 
Zone.
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A new pane will appear to the right. Make 
the desired changes, then select 
“Update” to save any changes. 

 

To Delete a Daylighting Zone, use the 
“Delete Daylight Zone” option at the 
bottom of the Edit pane.  

A confirmation window will appear. Select 
“Delete” again to confirm and delete the 
Zone. 

 

 

 

 

 

Users Tab 
The Users tab within the Room Node is the same as the Users tab at the main Project level. 
The only difference is that managing Users within the Room Node tab only affects Users 
within the current Room Node. This option is used to restrict User access to individual 
Rooms or Areas versus the entire Project. 

Refer to the previous Users Tab section for more information on managing Users. 
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Schedules 
Each GreenMAX DRC Room Controller can utilize Schedules and Calendars to change light 
levels, execute scenes, and even change Behavior settings such as occupancy timeouts 
and keypad operation. 

Schedules and Calanders can also be subscribed to reduce the number of Schedules and 
Calanders that need to be maintained within a Project. This allows for more centralized 
control of Schedules and Calendars. 

 

 

Adding a Schedule or Calendar 
To add a new Schedule or Calendar, select the Gear icon in the top right corner. Then select 
the + symbol on the right for either option.  
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Enter a Name, select the Type, and a color to represent the Schedule or Calander when 
viewing events on the Calander.  

 

The next step is to add Events/Dates to the Schedule/Calander. Below are screenshots of 
both configuration panes. 

Once the desired values have been configured, select “Save” to add the Event/Date. 
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Continue adding Events/Dates if needed. Then select “Save” in the top right corner to save 
the New Schedule or Calander. 

 

Editing or Deleting a Schedule/Calander or Event/Date 
To Edit or Delete a Schedule/Calander, select the Gear icon next to the Schedule/Calendar. 
The option to Delete a Schedule or Calendar appears once in the Edit view. 

 

Once inside the Schedule/Calander Edit view, Events/Dates can be edited and deleted by 
selecting the Gear or Trash icon respectively. When deleting a 
Schedule/Calendar/Event/Date, a confirmation prompt will appear. Select “Delete” again 
to confirm and delete. 
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Events Tab 
The Events tab within the Room Node is the same as the Events tab at the main Project 
level. Events can only be viewed in this tab. However the Events tab within the Room Node 
will only display Events within that Room Node versus for the entire Project when viewing 
the Events tab at the main Project level. 
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Diagnostics and Troubleshooting 
My Building Mobile App Logs 
The My Building mobile app generates logs that can be used for diagnostic purposes. If a 
Leviton representative requests logs, refer to the “Diagnostic Options” section found earlier 
in this manual to generate and send logs. 

Diagnostic LEDs 
Refer to device installation instructions for more information. 

Room Controller and Smart Packs 
Wi-Fi , Zigbee, and LumaCAN LEDs 

• Solid GREEN LED - feature is enabled, no traffic 
• Blinking GREEN LED - active network traffic 
• Off - feature is disabled 

Heartbeat LED 

• Solid RED LED – Failed application or processor failure 
• Blinking RED LED – Duplicate LumaCAN address 
• Solid WHITE LED – Processor has a reset or startup failure 
• Off – Failure or no power 

Switches 
• All LEDs Flashing (~1 sec per flash) – Device Address has not been set 
• All LEDs rapidly flashing – Discovering network 

Digital Sensors 
• Blinking RED LED - PIR movement is detected 
• Blinking GREEN LED - Microwave movement is detected 
• Rapid flashing WHITE LED - Firmware update is in progress 
• Slow flashing WHITE LED - Bootloader Mode 
• Flashing Multi-Color LEDs - Waiting on LumaCAN address assignment 

DRC Power Supply 
• Solid GREEN – Normal operation 
• Off – No power, short on LumaCAN network (CAT6), or over-current on LumaCAN 

network detected 
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Phase Cut Dimmers 
Temp LED 

• GREEN – Normal 
• AMBER – Warm 
• FLASHING RED – Hot  
• SOLID RED – Shutdown 

NET LED 

• Blinking GREEN– Active network traffic 
• Blinking CYAN – Waiting on LumaCAN address assignment 

DALI Interface 
Ethernet Link LED 

• Blinking – Active network traffic 

Ethernet Speed LED 

• Solid – Ethernet speed is 100Mbps 
• Off – Ethernet speed is 10Mbps 

DALI CH1 and CH2 LED 

• Intermittent Blink – Active network traffic 

Communication LED 

• Solid – Normal 
• Rapid Flashing – Duplicate LumaCAN address 

Status LED 

• Slow Blink – Normal 
• Rapid Blink – Bootloader Mode 

Multi-Channel Relays 
Network LED 

• Solid GREEN – LumaCAN connected 
• Blinking GREEN – Active network traffic 
• Blinking CYAN – Awaiting on LumaCAN address assignment 

Power LED 

• Solid GREEN – Normal 
• Off – No power 
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Overriding DRC Room Controllers and Smart Packs 
If the LumaCAN network is down or a device is not able to control a GreenMAX DRC Room 
Controller or Smart Pack over the network, lighting loads can be forced on. 

To override GreenMAX DRC Room Controllers and Smart Packs, disconnect both CAT6 
cables and toggle the EM Sense Switch to CAN Mode. The device will turn on its relay and 
raise its dim level to 100%. If the lights do not turn on and raise to 100% brightness, the 
device is either defective, the circuit feeding the lighting load is switched off, or light fixture 
is defective. 
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Overriding Multi-Channel Relays or Phase Dimmers 
If the LumaCAN network is down or a device is not able to control a GreenMAX DRC Mutli-
Channel relay or Phase Cut Dimmer over the network, lighting loads can be forced on. 

To override a a GreenMAX DRC Mutli-Channel relay or Phase Cut Dimmer, toggle the 
buttons on the front of the unit. Each button press will cycle through different dim levels 
and off. If the buttons do not respond or affect the connected loads, the unit may be 
defective. 

 
Multi-Channel Relays 
 

 
Phase Cut Dimmers 
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